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On the supplied software
• Copyright laws prohibit reproducing

the software or the software manual in
whole or in part, or renting the software
without the permission of the copyright
holder.

• In no event will SONY be liable for any
financial damage or loss of profits,
including claims made by third parties,
arising out of the use of the software
supplied with this player.

• In the event a problem occurs with this
software as a result of defective
manufacturing, SONY will replace it at
SONY’s option or issue a refund.
However, SONY bears no other
responsibility.

• The software provided with this player
cannot be used with equipment other
than that which it is designated for use
with.

• Please note that, due to continued
efforts to improve quality, the software
specifications may be changed without
notice.

Program © 2001 Sony Corporation, © 2001
Palm, Inc. or its subsidiaries. All rights
reserved.
Documentation © 2001 Sony Corporation

Sony, Memory Stick, the Memory Stick logo,
Jog Dial, and PictureGear are trademarks of
Sony Corporation.
Graffiti, HotSync, and Palm OS are
registered trademarks, and the HotSync logo
and Palm are trademarks of Palm, Inc. or its
subsidiaries.
IBM and PC/AT are registered trademarks
of International Business Machines
Corporation.
Microsoft, Windows, Windows NT, Outlook
and the Windows 98 logo are registered
trademarks of Microsoft Corporation.
MMX and Pentium are registered
trademarks of Intel Corporation.
AvantGo, the AvantGo Client and the
AvantGo logo are registered trademarks of
AvantGo, Inc.
Pumatech, the Pumatech logo, Intellisync
and Intellisync Lite are trademarks of
Pumatech, Inc. that may be registered in
some jurisdictions.
Adobe and Adobe Acrobat Reader are
trademarks of Adobe Systems Incorporated.
QuickTime and the QuickTime logo are
trademarks used under license. QuickTime
is registered in the U.S. and other countries.
This product includes fonts owned by
TypeBank Co., Ltd. under license.
All other trademarks are trademarks of their
respective owners.

Sample movies and music: cocoro.prc
(from DVD Hawaiian Breeze - KOHALA
Collection (CCBN-27013))
Music: Mango Cooler (Composed by
Charles Michael Brotman. Performed by
KOHALA)
Copyright © 2001 cocoronetworks, inc.
Copyright © 1998, 2001 Palm Records, Inc.
All rights reserved.
http://www.cocoronet.com/en/

CAUTION

Please contact your nearest Sony dealer
regarding the problem you are experiencing
with your Sony product.
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Welcome to the Sony Personal Entertainment Organizer (referred to as
the “Sony CLIÉ Handheld” or “CLIÉ handheld” in this manual).
Your Sony CLIÉ Handheld comes with three manuals:

Read This First
The Read This First manual gives you an overview of your CLIÉ
handheld’s features, hardware and software setup, installation
instructions, and other important details.  Before reading the other
manuals, read the Read This First manual.

Operating Instructions
The Operating Instructions manual describes all you need to know
about how to use your CLIÉ handheld and the Personal Information
Management (PIM) applications that come with it.
This manual shows you how to:

� Turn on and off your CLIÉ handheld, reset the CLIÉ handheld, and
enter data in greater detail (Chapter 1)

� Use the Personal Information Management applications:  Date
Book, Address Book, To Do List, Memo Pad, and Calculator
(Chapter 2)

� Perform a HotSync operation with your computer (Chapter 3)

� Exchange data with another handheld using beaming or Memory
Stick media (Chapter 4)

� Personalize your CLIÉ handheld with your own preferences
settings (Chapter 5)

� Maintain your CLIÉ handheld and use the Troubleshooting guide
and other technical information (Chapter 6)

About this manual
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Add-on Applications Guide (this manual)
The Add-on Applications Guide describes how to install and use the
supplied add-on applications, including;

� PictureGear™ Pocket/PhotoStand/PictureGear 4.4Lite

� CLIÉ Paint

� gMovie™

� World Alarm Clock

� CLIÉ Remote Commander

� Sound Utility/Sound Converter

� MS Autorun

� MS Import/Export

The three manuals all describe operations of two models of the CLIÉ
handheld (PEG-T615C and PEG-T415). All illustrations of the unit are
of PEG-T415, unless specified otherwise. Points of difference between
the two models are described in their relative sections.





Chapter 1

Chapter 1

Viewing image files
(PictureGear Pocket)

This chapter describes how to view image files
on your CLIÉ handheld.
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What you can do with PictureGear Pocket

PictureGear Pocket is a picture album application for your CLIÉ
handheld.

Anytime anywhere...
You can store still image files from various sources, including those
taken with a digital camera or downloaded from the Internet to your
CLIÉ handheld, using PictureGear Pocket application. You can look at
your favorite image files anytime and anywhere.

Using PictureGear Pocket as a photo stand or a clock
Using the PhotoStand function, you can display image files that are
drawn on a computer or image files taken with a digital camera.
You can also use your CLIÉ handheld to display the current time on
your CLIÉ handheld screen while using the PhotoStand function.

Beaming my image files ...
Use IR (Infrared) communication to exchange image files easily with
other CLIÉ handheld users. You cannot beam image files to other Palm
OS based devices.

Pasting an image file to an address entry
You can paste an image to an address entry.
For details, refer to the Operating Instructions manual.
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 PictureG
ear Pocket

Chapter 1

Installing

You do not have to install the PictureGear Pocket application on
your CLIÉ handheld
The PictureGear Pocket application is factory pre-installed. This
section describes how to install the PictureGear 4.4Lite software.

Installing the PictureGear 4.4Lite software on your
computer

You can convert the image files stored in your computer using the
PictureGear 4.4Lite software. To view image files or movies with your
CLIÉ handheld, use the PictureGear Pocket application or the gMovie
player respectively.

1 Insert the Installation CD-ROM into the CD-ROM drive.
The installation launcher window appears.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Install CLIÉ Utilities.

4 Click Install PictureGear Lite.
The PictureGear 4.4Lite software installation starts.
Follow the onscreen instructions  to finish installation.

5 Click Exit.

To start PictureGear 4.4Lite

From the Start Menu, click Programs (All Programs in
Windows® XP), PictureGear 4.4Lite, and PictureGear
4.4Lite.

For details on how to use the PictureGear 4.4Lite software, see the
Help files of the PictureGear 4.4Lite software.
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Viewing image files stored in your CLIÉ
handheld

You can transfer image files taken by a digital still camera or
downloaded from the Internet, etc. to your CLIÉ handheld. These
items can be managed using the PictureGear 4.4Lite software on your
computer. You can also  optimize the photos for displaying them on
your CLIÉ handheld using PictureGear 4.4Lite software before
transferring them to your CLIÉ handheld.
For details on how to save image files in the format supported by
PictureGear 4.4Lite software, refer to the instruction manual of the
devices or imaging software you are using.

Transferring image files to your CLIÉ handheld

Prepare and format the image files you want to display on your CLIÉ
handheld with the PictureGear 4.4Lite software, and then transfer
them to your CLIÉ handheld.

1 Start PictureGear 4.4Lite software.
See page 12 for details.

2 Select the image file you want to send.
You can also select multiple images by holding down the Ctrl or
Shift keys while clicking.

3 From the File menu, select Output services and then
Install the image during the next HotSync.
The User name dialog box appears.

4 Click the arrow V to the right of the text box, and then
select a user name.
If necessary, click “Still settings” and set the size and compression
for the image file you want to send in the Settings for PictureGear
dialog box.

5 Click OK.
The image file you want to send and the user name are registered in
PictureGear software.

6 Place your CLIÉ handheld on the cradle, then press the
HotSync button on the cradle.
The registered image file(s) are automatically sent to your CLIÉ
handheld during the HotSync operation.
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 PictureG
ear Pocket

Chapter 1

To save an image file to a Memory Stick media
You can also transfer image files directly to a Memory Stick media.
Install the MS Export software on your computer beforehand (page
93).

1 Connect the cradle to a computer in which you have
installed the MS Export software.

2 Insert a Memory Stick media in your CLIÉ handheld.

3 Place your CLIÉ handheld on the cradle.

4 On the Application Launcher screen of your CLIÉ
handheld, rotate the Jog Dial navigator to select MS
Import and press the Jog Dial navigator.
Or, tap the MS Import icon on the Application Launcher screen.
The MS Import application starts.

5 Start the PictureGear 4.4Lite software on your computer.

6 Select the desired image on the PictureGear 4.4Lite
software.

7 From the File menu on the same screen, click Output
services, then select “Output CLIE Handheld format file
to MemoryStick.”
The “Output CLIE Handheld format file to MemoryStick” dialog
box appears.

8 From the list next to Save into drive, select the Memory
Stick drive.

9 Click OK.
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Viewing image files stored in your CLIÉ handheld

Viewing image files with your CLIÉ handheld

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select PG Pocket and then press the Jog Dial
navigator.
Or, tap the PG Pocket icon on the Application Launcher screen.

PictureGear Pocket application starts.

2 Tap the arrow V on the top center of the screen to select
Internal.
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ear Pocket
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3 Rotate the Jog Dial navigator to display the desired
image file, then press the Jog Dial navigator.
Or, tap the desired image.
The selected image appears.

4 When you want to hide icons displayed at the bottom of
your CLIÉ handheld screen, tap  (hide icons).
When you want to display them again, tap the screen, or press the
Jog Dial navigator or the BACK button.

5 When you want to show another image file, rotate the
Jog Dial navigator.
Another image file appears.

6 To return to the photo list screen, tap , or press the
BACK button.
To return from the detailed information screen to the image file list
screen, tap Close on the lower right of the screen or press the BACK
button.

Continued on next page
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Viewing image files stored in your CLIÉ handheld

Viewing detailed information for the image file

Tap  (detailed) while the image file is displayed.
Detailed information for the image file appears.

Magnifying image files

1 Tap  while the image file is displayed.

2 Rotate the Jog Dial navigator to magnify the image file.
When you press the Jog Dial navigator, the image file is
automatically magnified on the screen.
If you rotate the Jog Dial navigator counter-clockwise, the image is
magnified. If you rotate the Jog Dial navigator clockwise, the image
is reduced.

3 If part of the image is outside the bounds of the screen,
you can pan by dragging on the screen with your stylus.

4 To return to the photo list screen, press the BACK
button.

Drawing on image files (CLIÉ Paint)
You can draw and paint on a PGP format image file stored on your
CLIÉ handheld with the CLIÉ Paint application. To start the CLIÉ
Paint application, tap  while the image file is displayed. For details
on the CLIÉ Paint application, see pages 31-40.
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Changing the image file list screen
You can change the image file list screen to display items by name and
date, or by thumbnail image.

To display the image file list by name and date (List mode)
Tap .

To display the image file list by thumbnail image (Preview mode)
Tap .

By name and date
(List mode)

By thumbnail image
(Preview mode)
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Viewing image files stored in
Memory Stick media

Image files shot by a digital still camera or digital video camera
recorder and recorded in a Memory Stick media are stored in the DCF
(Design rule for Camera File system) format. This format differs from
the PGP format which is the standard for the PictureGear Pocket
application.
You can view both PGP format image files and DCF format image files
using the PictureGear Pocket application. In addition, you can convert
DCF format image files into PGP format image files, and save them to
your CLIÉ handheld or Memory Stick media.

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select PG Pocket and press the Jog Dial
navigator.
Or, tap the PG Pocket icon on the Application Launcher screen.
The PictureGear Pocket application starts.

2 Insert the Memory Stick media into the Memory Stick
slot.

3 Tap the arrow V on the top center of the screen to select
MS.
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4 If you want to view DCF image files taken by digital still
cameras or etc., tap DCF.
If you want to view image files converted by the PictureGear Pocket
application or the PictureGear 4.4Lite software, tap PGP.

Note

You cannot move, copy or transfer DCF format image files using the MS Gate
application. However, you can convert them into PGP format image files using
PictureGear Pocket application, and save them to your CLIÉ handheld.

Notes on DCF format

• DCF (Design rule for Camera File system) is an industry standard format for
storing image files established by JEIDA (Japan Electronic Industry
Development Association).

• Using the PictureGear Pocket application, you cannot view image files shot by
a device that does not support the DCF format such as the Sony digital video
camera recorder DCR-TRV9000 or Sony digital still camera DSC-D700/D770.

• DCF format image files are stored in the DCIM directory of the Memory Stick
media.

• For best results, use the PictureGear 4.4Lite software on your computer to
convert the images to PGP format before storing them in a Memory Stick
media.
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Copying image files

Saving image files stored on your CLIÉ handheld to a
Memory Stick media (Export)

1 Display the image file that you want to save (page 14).

2 Tap  (Import/Export).
The Import/Export dialog box appears.
• To change the category of the image files, tap the arrow V and

select the desired category.
• If you want to delete the original image file stored on your CLIÉ

handheld, tap the check box next to Delete the original image.
• If you want to print the image with a DPOF (Digital Print Order

Format)-compatible printer, tap DCF, then tap to select Print
setting (DPOF). The selected image file will be saved on
Memory Stick media in DPOF.

3 Tap OK.
The selected image file is saved to the Memory Stick media.

Note

If you save images marked in DPOF to the Memory Stick media, all DPOF
settings for image files previously stored on the Memory Stick media will be
overwritten and cleared.

To cancel the operation
Tap Cancel in step 3 above.

Saving multiple image files to a Memory Stick media at once

1 In the photo list screen, tap  (Import/Export).
The check boxes used for selecting the image files appear.
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2 Tap the check boxes to select the image files you want
to save.

3 Tap Export.
The Import/Export dialog box appears.

4 Tap OK.

Saving image files stored on a Memory Stick media to
your CLIÉ handheld (Import)

1 Display the image file that you want to save (page 14).

2 Tap  (Import/Export).
The Import/Export dialog box appears.
• To change the category of the image files, tap the arrow V and

select the desired category.
• If you want to delete the original image file stored on the

Memory Stick media, tap the check box next to Delete the
original image.

3 Tap OK.
The selected image file is converted to the PGP format and saved to
the CLIÉ handheld. Depending on the image file, this may take a
few seconds.

To cancel the operation
Tap Cancel in step 3 above.
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Saving multiple image files to your CLIÉ handheld at once
You can copy both DCF and PGP format image files from a Memory
Stick media to your CLIÉ handheld with the following procedure. The
DCF image files will be automatically converted into PGP format.

1 In the photo list screen, tap  (Import/Export).
The check boxes used for selecting the image files appear.

2 Tap the check boxes to select the image files you want
to save.

3 Tap Import.
The Import/Export dialog box appears.

4 Tap OK.
The selected image files are saved to the CLIÉ handheld. Depending
on the image file, this may take a few seconds.

Copying image files
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Displaying image files one after another
(PhotoStand)

You can display image files one after another when you place your
CLIÉ handheld on the cradle (PhotoStand function).
You can also use your CLIÉ handheld as a clock by displaying the
current time using the PhotoStand application.

Making a PhotoStand setting

1 In the photo list screen of PictureGear Pocket, tap 
(PhotoStand).
The check boxes used for selecting the image files appear.

2 Tap to select the image file(s) which you want to display
with the PhotoStand function.

3 Tap PhotoStand.
The PhotoStand application starts, and the PhotoStand Settings
screen appears.

4 Make your settings.
• Title: Enter the desired Photo Stand title.
• Sort By: Select the order in which to display the image files.
• Effect: Select the transition effect to be used between images or

choose the clock type.
• Display Interval: Set an interval to determine the length of time

an individual image file will be displayed.
• Loop: If you do not want to repeat image files automatically

from the start, tap to deselect this check box.

Continued on next page
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• Show the icon on Home Screen: If you do not want to show
the icon of the file set for PhotoStand application on the
Application Launcher screen, tap to deselect this check box.

• Autorun: If you want to start PictureGear Pocket application when
you insert the Memory Stick media into your CLIÉ handheld, tap
to select this check box. This option appears only if you select the
images stored on the Memory Stick media for the PhotoStand.

5 Tap Save.
The image files that you selected in step 2 and the settings you
made in step 4 are saved with a PhotoStand title.

Note

Do not copy the Photostand settings to/from the Memory Stick media from/to
the CLIÉ handheld. A malfunction may occur.

Starting PhotoStand

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select PhotoStand and then press the Jog
Dial navigator. Or, tap the PhotoStand icon on the
Application Launcher screen.

PhotoStand application starts.

2 Tap the PhotoStand title that you want to play.

3 Tap Start.
Image files in the selected category appear one after another.

Exiting PhotoStand
Press the Jog Dial navigator or tap the screen.

For the PhotoStand title lists stored on the Memory Stick media
Select “VMS” in step 2.

Displaying image files one after another (PhotoStand)
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Viewing sample image files

You can view sample image files installed on your computer.
Install the Palm Desktop for CLIÉ software to your hard disk using the
supplied CD-ROM and then place your CLIÉ handheld on the cradle.

1 Double-click the Palm Desktop for CLIÉ icon on the
Windows desktop.
The Palm Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool dialog box appears.

3 Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select the folder manually.
At the default setup, Add-on folder is stored in the Sony Handheld
folder of the Program Files folder.

5 Double-click the PGPocket Samples folder.

6 Double-click the sample image file you want to view on
the screen of your CLIÉ handheld.
The selected image file name is added to the File Name list.
If you want to view other sample images, repeat this step.

7 Click Done.

8 Press the HotSync button on the cradle.
The selected sample image files will be installed on your CLIÉ
handheld.

9 Start PictureGear Pocket.
For details, see page 14.



26

How to read the online manual

Detailed information on the PictureGear Pocket application is
provided in the online manual in the supplied CD-ROM.
To view the online manual, the Adobe Acrobat Reader version 4.0 or
higher must be installed on your computer.

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Manuals.

4 Double-click PictureGear Pocket Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed/updated

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Click Exit.

3 Double-click the My Computer icon on the Windows
desktop.

4 Right-click the CD-ROM drive icon, then click Open from
the shortcut menu.

5 Double-click the PC folder.

6 Double-click the Acrobat folder.

7 Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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PictureGear Pocket menu items

The following items appear when you tap the MENU icon.
This section describes the menu commands specific to the PictureGear
Pocket application.

Photo list screen

View menu

List
Changes the view of the photo list screen.

PhotoStand
Starts the PhotoStand application.

Image menu

Import/Export
Shows the import/export screen.
Tap the check boxes to select the image file(s) you want to import/
export. For details, see “Copying image files” on page 20.

Delete
Shows the Delete screen.
Tap to select the image file(s) you want to delete. For details, refer to
the online manual.

Categorize
Shows the Categorize screen.
Tap to select the image file(s) you want to categorize. For details, refer
to the online manual.

Continued on next page
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PictureGear Pocket menu items

Options menu

Preference (available only when you view image files stored in
the Memory Stick media)
Shows the Preference screen.
Tap to select the default image format.

About PictureGear Pocket
Shows the version information of the PictureGear Pocket application.

Image file screen

View menu

Back
Returns to the photo list screen.

Details
Shows detailed information for the image file.

Zoom
Magnifies the image file. For details, see “Magnifying image files” on
page 16.

First Image
Shows the first image file.

Prev Image
Shows the previous image file.

Next Image
Shows the next image file.

Last Image
Shows the last image file.

Hide tool bar
Hides the tool bar at the bottom of the screen. Tap the image to show
the hidden tool bar.
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Image menu

Import/Export
Imports/exports the currently selected image file. For details, see
“Copying image files” on page 20.

Delete
Deletes the currently selected image file. For details, refer to the online
manual.

Beam
Beams the currently selected image file to another CLIÉ handheld.

CLIÉ Paint
The CLIÉ Paint application starts.

Options menu

Preference
Shows the Preference screen.

About PictureGear Pocket
Shows the version information of PictureGear Pocket application.





Chapter 2

Chapter 2

Drawing on image files
(CLIÉ Paint)

This chapter describes how to draw on image files
on your CLIÉ handheld.
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What you can do with CLIÉ Paint

CLIÉ Paint is a drawing tool application used to draw on PictureGear
Pocket images.

Drawing on image files stored on your CLIÉ handheld
Using the CLIÉ Paint application, you can draw and paint on a PGP
format image file stored on your CLIÉ handheld.

Notes

• The CLIÉ Paint application is compatible with the 16 bit color PictureGear
Pocket format (PGPF), and is not compatible with 8 bit color formats.

• Images in color will be displayed in monochrome for the monochrome display
models.
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 CLIÉ Paint
Chapter 2

Installing

Installing the CLIÉ Paint application on your CLIÉ
handheld

You can install the CLIÉ Paint application via your computer’s hard disk.
Place your CLIÉ handheld on the cradle, and install the Palm Desktop
for CLIÉ software on your computer from the supplied CD-ROM.

1 Double-click the Palm Desktop for CLIÉ icon on the
Windows desktop.
The Palm Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool dialog box appears.

3 Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select it manually.
At the default setup, the Add-on folder is stored in the Sony
Handheld folder of the Program Files folder.

5 Double-click the CLIÉ Paint folder.

6 Double-click the following folder.
• For PEG-T615C: Color folder
• For PEG-T415: Mono folder

7 Double-click the following file.
• For PEG-T615C: CLIÉPaint.prc
• For PEG-T415: CLIÉPaint_m.prc
The selected file is added to the File Name list.

8 Repeat steps 4 to 6 and double-click CPStamp.pdb.
CPStamp.pdb is added to the File Name list.

9 Click Done.

10 Press the HotSync button on the cradle.
The file specified in step 6 is installed on your CLIÉ handheld
during the HotSync operation.
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Starting CLIÉ Paint

To work on a white background

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select CLIÉ Paint and then press the Jog Dial
navigator.
Or, tap the CLIÉ Paint icon on the Application Launcher screen.

2 Tap to select the screen size of your drawing (320✕320,
320✕240, 160✕160, or 160✕120).
A white drawing area of the selected size is displayed.

To work on a PictureGear Pocket image

1 Display the desired image file on the screen following
steps 1 to 3 of “Viewing image files with your CLIÉ
handheld” on page 14.

2 Tap  shown on the bottom.

The CLIÉ Paint application starts.

 You cannot choose images stored on a Memory Stick media

If you tap  while you are viewing images stored on the Memory
Stick media with the PictureGear Pocket application, a message
appears and the CLIÉ Paint application does not start.
If the image file you wish to edit is stored on the Memory Stick media,
you must import it to the CLIÉ handheld using the PictureGear Pocket
application before starting the CLIÉ Paint application.  For details on
how to import the image files, see page 21.
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Drawing with CLIÉ Paint

Elements of the edit screen

1 Menu Button

Displays the menu screen.
• New Image: Displays a new white background to draw on.
• Load Image: Imports a PGP formatted image stored on the CLIÉ

handheld to the CLIÉ Paint application.
• Over-write: Over-writes the former image with the edited one

(the former image will not remain).
• Save As: Saves the edited image under a new name (the image

before editing will remain).
• : Shows the version information of the CLIÉ Paint

application.

2 UNDO/REDO

Cancels the last operation (UNDO), or when tapped right after
UNDO, recovers the cancelled operation(REDO).

Continued on next page
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3 Color palette

Shows the color or a grayscale shade for drawing letters or objects.
PEG-T615C: Choose the color/shade from the palette. The bottom
left tab of the palette shows the presently selected color/shade
(including color/shade sampled with the color sampler tool).
To edit the selected color/shade, tap the bottom left tab. Tapping it
displays the color-picker and the RGB color level bars. Select a color
or adjust the color level and tap OK to change the color. To return to
the palette without changing the color/shade, tap Cancel.
PEG-T415: Choose the shade from the displayed 16-step grayscale.

4 Tool switch bar

Switches the displayed tool icons with the three boxes on the bar.

5 Tool icons

Shows the tools to draw shapes, patterns and letters.
For details on how to use each tool, see page 37.

Drawing with CLIÉ Paint
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Painting with the tools

1 On the edit screen, tap the box on the Tool switch bar
until the tool of your choice is displayed.

2 Tap a palette tab to select a color/shade.

3 Tap to select the tool icon and draw on the image or the
white background.
•  Pen tool: Creates a free-hand line in the selected color/

shade.
•  Eraser tool: Erases an object drawn with a tool (pen, line,

ellipse, rectangle, rounded rectangle, letter, stamp, spray, blur,
mosaique).

Note

You cannot erase details of the original image file. You also cannot erase
the performed edits once it is saved.

•  Color sampler tool: Samples a color/shade from the
original image file to the color palette.

•  Scroll tool: Scrolls the image when you are editing a 320 ✕
320 image.

•  Line tool: Creates straight lines in the selected color/shade.
•   Ellipse tool (no fill/ solid fill): Creates ellipses in the

selected color/shade.
•   Rectangle tool (no fill/ solid fill): Creates rectangles in

the selected color/shade.
•   Rounded rectangle tool (no fill/ solid fill): Creates

rectangles with round-corners in the selected color/shade.
•  Letter tool: Select to draw letters on the image using the

onscreen keyboard or Graffiti®  writing.
After you enter the letters and tap OK, the entered letters are
displayed with a dotted border around it. In this state, you can
drag it with the stylus and change its location on the image.
Tap anywhere outside the dotted border to place it.

Continued on next page
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•  Pattern stamp tool: Lets you stamp various patterns on the
image.
After you tap to select the pattern, the selected pattern is
displayed with a dotted border around it. While it is boxed, you
can drag it with the stylus and change its location on the image.
Tap anywhere outside the dotted border to place it.

•  Spray tool: Gives a sprayed effect in the selected color/
shade.

•  Blur tool: Gives a blurred, soft-focus effect where you trace
with the stylus.

•  Mosaique tool: Gives a mosaique effect where you select
with the stylus.

Changing the stroke width, letter size, or spray size
Tap to select one of the four stroke icons or spray size icons.
With the stroke icon, you can change the stroke width for the following
tools: pen, eraser, line, ellipse (no fill), rectangle (no fill), rounded
rectangle (no fill), and blur. You can also change the letter size for the
letter tool with the stroke icons.
The spray size icon changes the spray size for the spray tool.

Drawing with CLIÉ Paint

Stroke icons Spray size icons
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Saving edited images

Saving edited image files on your CLIÉ handheld

1 When you finish the editing, tap  to save the file.
The Menu dialog box appears.

2 Tap Over-write or Save As.
• Over-write: Over-writes the former image with the edited one.

The former image will not remain on memory once overwritten.
• Save As: Saves the edited image under a new name (the image

before editing will remain on memory). You must enter a new
name for the edited image.

3 Tap OK.
The edited image file is converted to the PGP format and is saved
on the CLIÉ handheld.

Note

• Files processed in monochrome models (e.g. PEG-T415) are saved as a
monochrome image even if the original image file is in color.

• The edited images will not be saved on a Memory Stick media.

To quit the CLIÉ Paint application without saving the image

1 Tap any application button or Home .

If the edited image is not saved, a confirm dialog box appears.
2 Tap OK.

The application switches and the edited image will not be saved.
To return to the CLIÉ Paint application edit screen, tap Cancel.
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How to read the online manual

Detailed information on the CLIÉ Paint application is provided in the
online manual in the supplied CD-ROM.
To view the online manual, the Adobe Acrobat Reader version 4.0 or
higher must be installed on your computer.

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Manuals.

4 Double-click CLIÉ Paint Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed/updated

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Click Exit.

3 Double-click the My Computer icon on the Windows
desktop.

4 Right-click the CD-ROM drive icon, then click Open from
the shortcut menu.

5 Double-click the PC folder.

6 Double-click the Acrobat folder.

7 Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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Chapter 3

Playing a movie (gMovie player)

This chapter describes how to play a movie on your CLIÉ
handheld.
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What you can do with gMovie player

gMovie is an application which allows you to display or play back
movie file created with Windows® applications such as PictureGear
4.4Lite, on your CLIÉ handheld.

Playing movies on your CLIÉ handheld
You can play a movie that has been converted to the proper format
and then transferred from your computer, or stored in the Memory
Stick media. You can enjoy your favorite movies anytime, anywhere.
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Installing

You do not have to install gMovie player on your CLIÉ handheld
The gMovie player is factory pre-installed.

Install PictureGear 4.4Lite software on your computer

Install PictureGear 4.4Lite software on your computer according to the
instructions on page 11.
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Playing movies with your CLIÉ handheld

You can transfer to your CLIÉ handheld movies that are shot by a
digital still camera or downloaded from the Internet, etc., and that are
managed by the PictureGear 4.4Lite software on your computer. You
will need to optimize the movies on your CLIÉ handheld by the
PictureGear 4.4Lite software before transferring the movies.
For details on operations, or on how to save the movies in the format
supported by the PictureGear 4.4Lite software, refer to the online Help
of the PictureGear 4.4Lite software.

Transferring movies to your CLIÉ handheld

Prepare and format the items you want to display on your CLIÉ
handheld with PictureGear 4.4Lite software, and then transfer them to
your CLIÉ handheld.

1 Start PictureGear 4.4Lite software.
See page 11 for details.

2 Select the movie you want to send.
You can also select multiple movies by holding down the Ctrl or
Shift keys while clicking.

3 From the File menu, select Output services and then
Install the image during the next HotSync.
The User name dialog box appears.

4 Click the arrow V to the right of the text box, and then
select a user name.
If necessary, click Movie settings and set the size and compression
for the image you want to send in the “Settings for Movies on CLIÉ
Handheld” dialog box.

5 Click OK.
The images you want to send and the user name are registered in
the PictureGear software.

6 Place your CLIÉ handheld on the cradle, and then press
the HotSync button on the cradle.
The registered images are automatically sent to your CLIÉ handheld
during the HotSync operation.
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To save a movie to the Memory Stick media
You can also transfer movie files directly to a Memory Stick media.
Install the MS Export software on your computer beforehand (page
93).

1 Connect the cradle to a computer in which you have
installed the MS Export software.

2 Insert a Memory Stick media in your CLIÉ handheld.

3 Place your CLIÉ handheld on the cradle.

4 On the Application Launcher screen of your CLIÉ
handheld, rotate the Jog Dial navigator to select MS
Import and press the Jog Dial navigator.
Or, tap the MS Import icon on the Application Launcher screen.
The MS Import application starts.

5 Start the PictureGear 4.4Lite software on your computer.

6 Select the desired movie on the PictureGear 4.4Lite
software.

7 From the File menu on the same screen, click Output
services, then select “Output CLIE Handheld format file
to MemoryStick.”
The “Output CLIE Handheld format file to MemoryStick” dialog
box appears.

8 From the list next to Save into drive, select the Memory
Stick drive.

9 Click OK.
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Playing movies with your CLIÉ handheld

Playing movies

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select gMovie and then press the Jog Dial
navigator.
Or, tap the gMovie icon on the Application Launcher screen.

The gMovie player starts and the movie list screen appears.

2 Tap the movie you want to play.
Playback starts.

To stop playback
Tap  (Stop).
To resume playback, tap  (Play).

To locate the starting point of the movie
Tap  (Locate).
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To return to the movie list screen
Tap  (Return) at the upper-right corner of the screen.

To play the next movie
Tap  (Next) at the upper-right corner of the screen.

To play movies one after another (continuous playback)
Tap and hold  (Next) at the upper-right corner of the screen for a few
seconds.
The icon changes into  (Continuous) and movies stored in your CLIÉ
handheld are played one after another.
To return to the normal playback, tap and hold  (Continuous) for a
few seconds.

To delete a movie

1 Display the movie you want to delete, and then tap
Menu .

2 Tap Delete.

3 Tap OK.
The selected movie is deleted, and then the movie list screen
appears.
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Playing sample movie files

You can view sample movie files installed on your computer.
Install the Palm Desktop for CLIÉ software to your hard disk using the
supplied CD-ROM and then place your CLIÉ handheld on the cradle.

1 Double-click the Palm Desktop for CLIÉ icon on the
Windows desktop.
The Palm Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool dialog box appears.

3 Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select the folder manually.
At the default setup, Add-on folder is stored in the Sony Handheld
folder of the Program Files folder.

5 Double-click the gMovie Samples folder.

6 Double-click the sample movie file you want to play on
the screen of your CLIÉ handheld.
The selected movie file name is added to the File Name list.
If you want to view other sample movies, repeat this step.

7 Click Done.

8 Press the HotSync button on the cradle.
The selected sample movie files will be installed on your CLIÉ
handheld.

9 Start gMovie player.
For details, see page 46.
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How to read the online manual

Detailed information on gMovie player is provided in the online
manual on the supplied CD-ROM.
To view the online manual, the Adobe Acrobat Reader version 4.0 or
higher must be installed on your computer.

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Manuals.

4 Double-click gMovie Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed/updated

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Click Exit.

3 Double-click the My Computer icon on the Windows
desktop.

4 Right-click the CD-ROM drive icon, then click Open from
the shortcut menu.

5 Double-click the PC folder.

6 Double-click the Acrobat folder.

7 Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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The following items appear when you tap the MENU icon on your
CLIÉ handheld screen.
This section describes the menu commands specific to gMovie player.

Media list screen

Media menu

About gMovie
Shows version information of the gMovie application.

Movie file screen

Media menu

Details
Shows detailed information of the current media.

Beam Media
Transfers the data contained in the current media to another CLIÉ
handheld via the IR port. For details about beaming, see the Operating
Instructions manual supplied with the CLIÉ handheld.

Delete
Deletes the current media. Tap OK in the Delete Media dialog box to
perform deletion. Tap Cancel to cancel deletion.

Preferences
Displays the available options for movie playback:
• Loop movie playback: If you want to play the current movie file

repeatedly, tap to select this check box.
When this check box is cleared, movies will no longer play
continuously.

About gMovie
Shows version information of the gMovie application.

gMovie menu items
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Chapter 4

Viewing the World Alarm Clock
(World Alarm Clock)

This chapter describes how to use your CLIÉ handheld as an
alarm clock showing the world time and date.



52

What you can do with World Alarm Clock

The World Alarm Clock is an application that you can install on your
CLIÉ handheld and that provides you with an additional clock, which
can give you the local time, the time around the world, and also work
as an alarm clock.

As a clock showing local time
You can view the present local time on your World Alarm Clock
application, and also set the clock to show Daylight Saving Time.

As a world clock showing the time around the world
In addition to the local time of your area, you can also view on your
World Alarm Clock application the local time of up to three other areas
of your choice around the world in a single time line, and the date of
each area. The world clock time line enables you to see whether you
are ahead or behind of a certain area in time and date, and can thus
help you in communicating with your business partners worldwide.

As an alarm clock capable of a variety of sounds
You can set several alarms on your World Alarm Clock application (in
a variety of patterns, e.g. vibrator, LED ) for a certain time or day of the
week. The tone for the alarm can be selected from among the sound
files you have installed on your CLIÉ handheld or from the
preinstalled sound files.
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Installing

You can install the World Alarm Clock application via your
computer’s hard disk.
Place your CLIÉ handheld on the cradle, and then install the Palm
Desktop for CLIÉ software on your computer from the supplied CD-
ROM.

1 Double-click the Palm Desktop for CLIÉ icon on the
Windows desktop.
The Palm Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool dialog box appears.

3 Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select it manually.
At the default setup, the Add-on folder is stored in the Sony
Handheld folder of the Program Files folder.

5 Double-click the WAC folder.

6 Double-click WAC_enUS.prc.
WAC_enUS.prc is added to the File Name list.

7 Click Done.

8 Press the HotSync button on the cradle.
The file specified in step 6 is installed on your CLIÉ handheld
during the HotSync operation.
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Using the World Alarm Clock

Viewing world time

1 On the Application Launcher screen, rotate the Jog Dial™
navigator to select WA Clock and then press the Jog Dial
navigator. Or, tap the WA Clock icon on the Application
Launcher screen.

The World Alarm Clock application starts and the clock screen is
displayed.

Elements of the clock screen

Note

The World Alarm Clock application displays the time according to the time
setting for the CLIÉ handheld. Make sure you set the correct date and time in the
CLIÉ handheld’s Date & Time Preferences screen. For details, refer to Chapter 5
of the Operating Instructions manual.

The clock with the time
and date of your present
time zone (all of which you
set for your CLIÉ handheld)

Time line with the date

The clock for different time
zones
 (To select the time zones
you wish to view here, see
“Selecting other time zones
to be displayed” on page
55.)

Daylight Saving Time  icon:
Tap to change the indicated time to
daylight saving time (the color or
shade of the icon changes). Tap
again to return to former
indication.

Set Alarm  icon:
If an alarm is set, the
icon will be marked
black.



55

 W
orld A

larm
 Clock

Chapter 4

Selecting other time zones to be displayed
You can select up to three areas to be displayed other than your
present location. The time and date for these other areas will be
displayed on the lower half of the clock screen.

1 On the clock screen, tap the area name (the default
setting is “USA (Pacific)”) for the smaller clock on the
lower half of the screen.
The Set Time Zone screen appears.

2 Tap to select the time zone, and tap OK.

Previewing the future time and date
You can preview the time and date ahead of the present time with the
Jog Dial navigator. Rotate the Jog Dial navigator to preview the future
time for all time zones in 15 minute units.
To return to the present time view, wait ten seconds or press the BACK
button.

Setting the clock alarm

You can set up to five alarms. To set an alarm for other days or days of
the week, set an alarm within the Date Book. See “Editing Date Book
events” in the Operating Instructions manual for details.

1 On the clock screen, tap the Set Alarm  icon next to
the Alarm  mark.
The Set Alarm screen appears. If you already have an alarm set on
the selected number, the Set Alarm screen for the last set alarm will
be displayed.

Continued on next page

Set Alarm  icon
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2 Tap the arrow V next to Off, and select On.

3 On the Comment line, enter a note that you would like
to attach to the alarm.

4 Tap the Time box.
The Set Time screen appears.

5 Set the time.
1 Tap the hour box and tap the arrow v or V to set the hour.
2 Tap the minute box and tap the arrow v or V to set the minute.
3 Tap to select AM or PM.

6 Tap OK.
The display returns to the Set Alarm screen.

7 Tap the numbered/lettered box to set a one-time or
repeating alarm.
• 1: Sets a one-time alarm.
• E: Sets a daily repeating alarm.
• S, M, T, W, T, F, S: Sets a weekly repeating alarm. You can select

more than one day of the week.

8 Set the alarm type.
1 Tap the check boxes to select the type of alarm from Sound,

Vibration, or LED.
A combination of two or all three will work as well.

2 If you selected Sound in 1: Select the tone of the alarm. Tap the
arrow V beneath the Sound check box to select from the drop-
down list.

Tip

If you import a tone of your choice to your CLIÉ handheld using the
Sound Converter software, they will appear here in the drop-down list.

Using the World Alarm Clock
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3 If you selected Sound in 1: Select the way you want the alarm
to sound.

• Crescendo: Tap the check box to select this if you want the
alarm to increase its volume while it sounds.

• Duration: Tap the arrow V next to this item to select the length
of time the alarm will go on when left alone. The choices are 5,
10, 15, 30 or 45 seconds.

Notes

• If the alarm volume is low, Crescendo may not function.
• Be sure to set the time length in Duration so that it is more than

twice the length of the sound file, or else Crescendo will not
function.

9 Select the repeating options.
• Remind Me: Select how many times the alarm repeats itself. The

choices are Once, Twice, 3 Times, 5 Times, or 10 Times.
• Play Every: Select how often the alarm repeats itself. The choices

of interval are 1, 3, 5, 10, 15, 20, or 30 minutes.

10 Tap OK.
The display returns to the clock screen.
The Set Alarm  icon for the active alarms will be marked black (  ).

Changing the alarm setting

1 On the clock screen, tap the Set Alarm  icon of the
alarm you wish to change.
The Set Alarm screen for that alarm appears.

2 Make the changes in the Set Alarm screen.

3 Tap OK.

Tip

To clear the set setting, tap Default in the Set Alarm screen. The setting for that
alarm number will return to the default setting.
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Cancelling a set alarm
You can deactivate an alarm without deleting its setting.

1 On the clock screen, tap the Set Alarm  icon of  the
alarm you wish to cancel.
The Set Alarm screen for that alarm appears.

2 Tap the arrow V next to On, and select Off from the
drop-down list.
The alarm will be deactivated while the setting remains.
The deactivated alarms will have no black dots in their circle.

Note

If you select Off for Alarm Sound/Vibrate Alarm/LED Alarm in the General
Preferences screen, the sound/vibration/LED of the alarm will be
deactivated even if you have selected Alarm On here.

Stopping the alarm

When the alarm goes off, a dialog screen appears.
To turn off the alarm and close the screen, tap OK. To have the alarm
stop and go off again after a few minutes, tap Snooze.

If you do not turn off the alarm
The alarm goes off again according to what you set for Remind Me in
step 9 on page 57.

If you tap Snooze
An alarm goes off approximately every 5 minutes until you stop the
alarm.

Using the World Alarm Clock
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How to read the online manual

Detailed information on the World Alarm Clock application is
provided in the online manual of the software on the supplied CD-
ROM.
To view the World Alarm Clock online manual, the Adobe Acrobat
Reader version 4.0 or higher must be installed on your computer.

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Manuals.

4 Double-click World Alarm Clock Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed/updated

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Click Exit.

3 Double-click the My Computer icon on the Windows
desktop.

4 Right-click the CD-ROM drive icon, then click Open from
the shortcut menu.

5 Double-click the PC folder.

6 Double-click the Acrobat folder.

7 Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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World Alarm Clock menu items

The following item appears when you tap the MENU icon.
This section describes the menu command specific to World Alarm
Clock application.

Options menu

Day Color
Set a different color for each day of the week.
The color is displayed in monochrome for monochrome models.

About World Alarm Clock
Shows the version information of World Alarm Clock application.



Chapter 5

Chapter 5

Using your CLIÉ handheld as a remote
commander (CLIÉ Remote Commander)

This chapter describes how to use your CLIÉ handheld as a
remote commander to control various devices.
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What you can do with CLIÉ Remote
Commander

The CLIÉ Remote Commander is an application you can install on
your CLIÉ handheld to enable the CLIÉ handheld to function as a
remote commander.

A single remote control for multiple devices
You can control a variety of remote-controlled devices (e.g. TV, VCR,
DVD player) with a single CLIÉ handheld, switching among them
with a tap on the quick-start buttons.

Customizable to suit your needs
If the four quick-start buttons are not enough to suit your needs, you
can always set more devices and select them from the Select menu.

You don’t even need to look at the screen...
You can assign operations to the Jog Dial™ navigator or to the
application buttons on the front panel. For example, if you assign
“increase volume” of a certain device to the upward rotation of the Jog
Dial navigator, you can always change the volume of that device in
that way without switching the control screen.
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Installing

You can install the CLIÉ Remote Commander application via your
computer’s hard disk. Before installation, be sure to have the Palm
Desktop for CLIÉ software installed on your computer, and have the
CLIÉ handheld seated correctly in the cradle.

1 Double-click the Palm Desktop for CLIÉ icon on the
Windows desktop.
The Palm Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool dialog box appears.

3 Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select it manually.
At the default setup, the Add-on folder is stored in the Sony
Handheld folder of the Program Files folder.

5 Double-click the RMC folder.

6 Double-click the following folder.
• For PEG-T615C: Color folder
• For PEG-T415: Mono folder

7 Double-click the following file.
• For PEG-T615C: CLIÉ_RMC.prc
• For PEG-T415: CLIÉ_RMC_m.prc
The selected file is added to the File Name list.

8 Repeat steps 4 to 6, and double-click the necessary files
with the name “-def.prc” (e.g. TVdef.prc) for PEG-T615C,
or “-def_m.prc” (e.g. TVdef_m.prc) for PEG-T415.
The files are added to the File Name list.

9 Click Done.

10 Press the HotSync button on the cradle.
Files specified in steps 7 and 8 are installed on your CLIÉ handheld
during the HotSync operation.

Note

The CLIÉ Remote Commander application does not start unless the
“-def.prc” applications are installed on your CLIÉ handheld.
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Preparing the CLIÉ Remote Commander
for your use

Assigning devices to the CLIÉ Remote Commander

Note

To check whether the manufacturer of your remote-controlled device is
supported by the CLIÉ Remote Commander application, refer to the “Appendix”
on page 102.

1 On the Application Launcher screen, rotate the
Jog Dial™ navigator to select CLIÉ RMC and press the
Jog Dial navigator. Or, tap the CLIÉ RMC icon on the
Application Launcher screen.

The CLIÉ Remote Commander application starts and a list of the
pre-assigned device is displayed.

2 Tap New.
The New Entry screen is displayed.
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3 Tap the arrow V next to the following items and select
the appropriate settings for your device(s).
• Category: Select the device you want to remote-control. Select

from TV, VCR, DVD, AV-AMP (amplifier).
• Maker: Select the manufacturing company of the remote-

controlled device from the drop-down list.
• Mode: Select the remote control mode from the drop-down list

(different models may require a different mode in order to operate).
• Button: Select which quick-start button you wish to assign the

device to. Choose the letter from the drop-down list, or select
none.

4 Point the IR port of the CLIÉ handheld toward the device
you want to remote-control and tap Test (power on/off).
If the device does not respond to the CLIÉ Remote Commander,
select a different mode type in step 3.

5 In the Name box, enter a name for this remote control
setting (e.g. VCR in the den).

6 Tap OK.
A confirm dialog box appears.

7 Tap OK.
The remote control setting is assigned to the selected quick-start
button, and the control screen for the assigned device appears.

8 To assign more devices to the other quick-start buttons,
tap Select on the control screen and repeat steps 2 to 7.

Note

Even if the manufacturer of the device is listed on the supported manufacturer
list on page 102, some devices cannot be remote-controlled depending on its
model or the year of its production.

Example of the VCR remote
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Changing the remote control setting

1 Tap Menu  on the control screen of the device of
which you want to change the remote control settings.

2 Tap Detail from the Options menu.
The Detail screen appears.

3 Make changes as necessary and tap OK.
The CLIÉ RMC dialog box appears.

4 Tap OK.
The new remote control setting is set, and the control screen for the
assigned device appears.

Deleting a remote control setting
Tap Delete in step 2 of “Changing the remote control setting” and tap
OK.

Preparing the CLIÉ remote commander for your use
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Assigning operations to the application buttons and
Jog Dial navigator

You can assign operations to the Jog Dial™ navigator or to the
application buttons on the front panel. This is convenient for those
operations you perform most (e.g. adjusting the TV volume), since you
do not even have to take out the stylus to operate.

1 On the Application Launcher screen, rotate the
Jog Dial™ navigator to select CLIÉ RMC and then press
the Jog Dial navigator. Or, tap the CLIÉ RMC icon on the
Application Launcher screen.
CLIÉ Remote Commander starts and the control screen of the last
used device is displayed.

2 Tap Menu .

3 Tap Key Assignment from the Options menu.
The Key Assignment screen appears.

4 If the check box for Use Key Assignment at the bottom
right corner is not selected, tap to select it.
If the check box is unmarked, application buttons and Jog Dial
navigator cannot be used in the CLIÉ Remote Commander
application even if operations are assigned to them.

Continued on next page
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5 Tap the box next to each assignable button (e.g. JOG
Up).
The Key Assignment dialog box for each button appears.

6 Tap the arrow V next to Entry, and select the name of
the remote control setting you wish to assign to the key.

7 Tap the arrow V next to Function, and select the
operation you want to assign to that button.

8 Tap OK.

9 Repeat steps 3 to 8 until you have finished setting all the
functions that you want.

10 Tap OK on the Key Assignment screen.

Preparing the CLIÉ remote commander for your use
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Using the CLIÉ handheld as a remote
commander

You can operate a remote-controlled device on the device’s control
screen. For those operations you have assigned to the Jog Dial™

navigator or to the application buttons, see page 67.

Notes

• Be sure to point the IR port of your CLIÉ handheld toward the
device that you wish to remote-control.

• The reach of the remote-control signal is approximately 5 meters, but
it may vary depending on the receiving device or on the
environment.

Remote-controlling a device

Operating a device from the control screen

1 On the Application Launcher screen, rotate the Jog Dial™
navigator to select CLIÉ RMC and press the Jog Dial
navigator. Or, tap the CLIÉ RMC icon on the Application
Launcher screen.
CLIÉ Remote Commander application starts and control screen for
the last used device appears.

Note

If the setting for the last used device has been deleted, the Select Control
screen appears.

2 Perform either of the following to switch to the control
screen of the device you are about to remote-control.
• For devices assigned to a quick-start button:

Tap the quick-start button to which it is assigned.
• For devices unassigned to a quick-start button:

Tap Select, then tap to select the name of the remote
control setting from the list.

The control screen for the selected device appears.

3 Tap the onscreen buttons to remote-control the device.



70

Operating devices directly with the Jog Dial navigator or the
application button

Follow the steps below to perform the assigned operation from the Jog
Dial navigator or the application buttons.

1 Start CLIÉ Remote Commander.

2 Use the Jog Dial navigator or the application buttons to
remote-control the device.

Viewing the device name assigned to each quick-start button

Tap a quick-start button and hold for over two seconds. The name of
the device assigned to each quick-start button is displayed.

Using the CLIÉ handheld as a remote commander

Quick-start button
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How to read the online manual

Detailed information on the CLIÉ Remote Commander application is
provided in the online manual of the application on the supplied CD-
ROM.
To view the CLIÉ Remote Commander online manual, the Adobe
Acrobat Reader version 4.0 or higher must be installed on your
computer.

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Manuals.

4 Double-click CLIÉ Remote Commander Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed/updated

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Click Exit.

3 Double-click the My Computer icon on the Windows
desktop.

4 Right-click the CD-ROM drive icon, then click Open from
the shortcut menu.

5 Double-click the PC folder.

6 Double-click the Acrobat folder.

7 Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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CLIÉ Remote Commander menu items

The following items appear when you tap the MENU icon.
This section describes the menu commands specific to the CLIÉ
Remote Commander application. For the Edit menu, see “Using the
edit menu” in the Operating Instructions manual.

Options menu

Detail
Shows the remote control setting for the displayed control screen.

Key Assignment
The Key Assign screen appears. You can assign operations to the
application buttons and the Jog Dial navigator.

About CLIÉ RMC
Shows the version information of the CLIÉ Remote Commander
application.
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Chapter 6

Importing your favorite sounds
(Sound Utility/Sound Converter)

This chapter describes how to import sound data
from your computer to your CLIÉ handheld.
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What you can do with Sound Converter/
Sound Utility

The Sound Converter software converts “WAVE format” or “Standard
MIDI File Format 0” sound data on your computer to sound data
compatible with the format used by your CLIÉ handheld. The Sound
Utility application then enables you to play those converted data on
your CLIÉ handheld.

Playing sound data on your CLIÉ handheld
Using the Sound Utility application, you can play a sound data that
has been transferred from your computer and converted to the CLIÉ
handheld compatible format.

Set your favorite sound data as an alarm sound
You can set an  imported sound data as an alarm sound on the Date
book and on the World Alarm Clock applications.

WAVE formats compatible with
Sound Converter are as follows:

fs = 8 kHz, 16 bit, stereo
fs = 8 kHz, 16 bit, monaural
fs = 8 kHz, 8 bit, stereo
fs = 8 kHz, 8 bit, monaural
fs = 22 kHz, 16 bit, stereo
fs = 22 kHz, 16 bit, monaural
fs = 22 kHz, 8 bit, stereo
fs = 22 kHz, 8 bit, monaural
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Installing

You must install the Sound Utility application on your CLIÉ handheld
and the Sound Converter software on your computer to use the
functions described in this chapter.

Installing the Sound Utility application on your CLIÉ
handheld

You can install the Sound Utility application via your computer’s hard disk.
Place your CLIÉ handheld on the cradle, then install the Palm Desktop
for CLIÉ software on your computer from the supplied CD-ROM.

1 Double-click the Palm Desktop for CLIÉ icon on the
Windows desktop.
The Palm Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool dialog box appears.

3 Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select it manually.
At the default setup, the Add-on folder is stored in the Sony
Handheld folder of the Program Files folder.

5 Double-click the Sound Utility folder.

6 Double-click SoundUtility_enUS.prc.
SoundUtility_enUS.prc is added to the File Name list.

7 Click Done.

8 Press the HotSync button on the cradle.
The file specified in step 6 is installed on your CLIÉ handheld
during the HotSync operation.
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Installing

Installing the Sound Converter software on your
computer

Install the Sound Converter software on your computer using the
supplied Installation CD-ROM.

1 Insert the Installation CD-ROM to your computer’s
CD-ROM drive.
The installation launcher window appears.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Install CLIÉ Utilities.
The CLIÉ Utilities window appears.

4 Click Install Sound Converter.
The software installation starts. Follow the onscreen instructions to
finish the installation.

5 Click Finish.

To start Sound Converter

From the Start menu, click Programs (All Programs in
Windows® XP), Sound Converter, and Sound Converter.

For details on how to use the Sound Converter software, see the Help
files of the Sound Converter software.
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Storing sound data in your CLIÉ handheld

Using the Sound Converter software, you can convert “WAVE format”
and “Standard MIDI File Format 0” sound data on your computer.
Converted data can be transferred to your CLIÉ handheld via a
HotSync operation.

Transferring sound data to your CLIÉ handheld

On your computer, prepare sound data to be played back on your
CLIÉ handheld, then transfer them to your CLIÉ handheld.

1 Start Sound Converter.
See page 76 for details.

2 Select the sound data to be transferred to your CLIÉ
handheld.
1 Click the Add button.

The Open dialog box appears.
2 Select the desired sound data from your computer’s drive, then

click Open.
You can also add files by dragging and dropping the desired
files directly to the Sound Converter window.
The files are added to the file list.

3 Click the Install button.
The Start Installation dialog box appears.

4 Select the User name of your CLIÉ handheld.
The registered sound data are automatically transferred to your
CLIÉ handheld during the HotSync operation.

5 Click the Execute button.
The Installation Complete dialog box appears, and the data are set
to be installed in the next HotSync operation.

6 Click OK.

7 Press the HotSync button on the cradle.
The selected sound data are installed on your CLIÉ handheld.

Note

If the converted sound data size exceeds approximately 64 KB, the exceeding part
is deleted.
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Storing sound data in your CLIÉ handheld

Setting an imported sound data as an alarm sound

You can set your favorite sound as an alarm sound with the Date Book
and the World Alarm Clock applications. Imported sound data are
automatically registered in the alarm sounds list in addition to the
default sounds.
For details on how to change the alarm sound, see “Using the Date
Book menus” in the Operating Instructions and “Setting the clock
alarm” in this guide (page 55).

Date book World Alarm Clock
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Managing sound data

You can manage the imported sound data using the Sound Utility
application on your CLIÉ handheld.

Playing sound data on your CLIÉ handheld

You can play transferred sound data using the Sound Utility

application.

1 On the Application Launcher screen, rotate the Jog Dial™

navigator to select Sound Utl and then press the Jog Dial
navigator.
Or, tap the Sound Utl icon on the Application Launcher screen.

Sound Utility starts and the imported sound data list is displayed.

2 Tap the desired sound data in the data list, then tap .
Playback starts.

Note

Select one data per playback. You cannot select two or more data
simultaneously.

Continued on next page
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To stop playback

Tap .

If the sound data are hard to hear
Lower the sound level of the original sound data, then transfer the
data to your CLIÉ handheld again.

1 Delete the sound data (see the following section for details).

2 Perform steps 1 to 2 on page 77.
3 Click the desired data from the data list.
4 From the Edit menu, click Conversion Volume Control.

The Conversion Volume Control window is displayed.
5 Adjust the volume by sliding the volume bar.
6 Click OK.
7 Perform steps 3 to 7 on page 77.

Notes

• It is not guaranteed that all the sound data become easier to hear with the
above procedure.

• The tone of MIDI format sound data may sound different when played back on
the CLIÉ handheld.

Note on sound data
The playback sound may be distorted depending on its tone and volume.

Deleting a sound data

You can delete unnecessary sound data from your CLIÉ handheld.

1 From the Sound Utility window, tap the desired sound
data in the data list, then tap Delete.
The Delete Sound Data dialog box appears.

2 Tap OK.
The selected data is deleted, and the data list is updated.

Note

All sound data are stored as two sound files (SMF file, PCM file) in your CLIÉ
handheld according to the data type. In case you delete the sound data by
mistake, it is recommended to back up these two files. For details, see the
Operating Instructions manual provided in the supplied CD-ROM.

Managing sound data
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Changing the name of a sound data

1 From the Sound Utility window, tap the desired sound
data in the data list, then tap Rename.
The Rename Sound Data dialog box appears.

2 Type the desired name and tap OK.
The selected data name is changed, and the data list is  updated.

Sorting the sound data list

You can sort the data list by name, size, playback time, or data type.

Tip

To sort by the data type, select one of the following:

• SMF: A list of Standard MIDI File Format 0 data is displayed.

• PCM: A list of WAVE format data is displayed. The WAVE format
data are stored as PCM (ADPCM) format in your CLIÉ handheld.

To sort by name

Tap the right end of the Name bar in the data list.
Tapping the right end repeatedly changes over the alphabetical order
up and down.

To sort by size, time, or type
1 Tap the Size, Time, or Type bar in the data list, then select

the desired category.

The information on selected category is displayed.
2 Tap the right end of the Size, Time, or Type bar.

Tapping the right end repeatedly changes over the order up and
down.
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Sound Utility menu items

The following item appears when you tap the MENU icon.
This section describes the menu command specific to the Sound Utility
application.

Options menu

About Sound Utility
Shows the version information of Sound Utility application.
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Setting the Memory Stick automatic start
function (MS Autorun)

This chapter describes how to set the Memory Stick
automatic start function on your CLIÉ handheld.
If you want to start an application in the Memory Stick
media from the Application Launcher screen, refer to the
Operating Instructions manual.
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What you can do with MS Autorun

Memory Stick Autorun (hereafter referred to as MS Autorun) is an
application which allows your CLIÉ handheld to copy and start a
specified application automatically when Memory Stick media is
inserted into the CLIÉ handheld. Removing the Memory Stick media
automatically deletes the application copy from the memory of the
CLIÉ handheld.  MS Autorun functions as a virtual memory to
effectively utilize the memory of the CLIÉ handheld.

Starting an application (.prc) on the CLIÉ handheld automatically
If you use a digital still camera that is compatible with Memory Stick
media, you can view your images by inserting the Memory Stick
media into the CLIÉ handheld. In such a case, you would use the auto-
run setting to start the PictureGear Pocket application on your CLIÉ
handheld.

Starting an application (.prc) in a Memory Stick media
automatically
This setting is for automatically starting an application which does not
access any data, such as game applications, or an application which
accesses data in the CLIÉ handheld (not in the Memory Stick media).

Starting a pre-selected application (.prc) and related database
files (.pdb, .prc) in a Memory Stick media*
This setting automatically displays a specific image or file with an
application such as an image viewer or a document reader. You need
to specify an application and the related database files before using
this auto-run setting.

Starting an application (.prc) on the CLIÉ handheld automatically
with specific database files (.pdb, .prc) from a Memory Stick
media*
This setting is used if the application is located on the CLIÉ handheld and
the corresponding database files are located on a Memory Stick media.
You can also display the desired data automatically by inserting the
Memory Stick media into your CLIÉ handheld.

* If you specify PictureGear Pocket as an auto-run application, tap the arrow V
on the top center of the screen in the PictureGear Pocket application to select
“MS.” Likewise, if you specify gMovie player as an auto-run application, tap
the movie file you want to play.
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Notes

• It is not recommended that you use MS Autorun application with the Address
Book, Date Book, To Do List, Memo Pad, Calculator or Mail applications.
Problems may occur if the data of these applications do not reside on your
CLIÉ handheld when you perform a HotSync operation.

• The specified application may not start automatically depending on the
application in use when you insert the Memory Stick media into your CLIÉ
handheld. In this case, return to the Application Launcher screen, and then
reinsert the Memory Stick media.

You do not have to install MS Autorun on your CLIÉ
handheld

The MS Autorun application is factory pre-installed.
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Setting Auto-run for an application

To automatically start an application stored in a Memory Stick media,
perform the following procedure.

Note

This procedure is an example to set the PictureGear Pocket application to start
automatically. In this case, a Memory Stick media containing photos must be
inserted to the CLIÉ handheld.

1 Install an application you want to start automatically
(PictureGear Pocket) on the CLIÉ handheld.
The PictureGear Pocket application is preinstalled in some series of
the CLIÉ handheld, including this model.

2 Insert the Memory Stick media for which you want to set
the auto-run function to into the Memory Stick slot.

3 On the Application Launcher screen, rotate the Jog Dial
navigator to select MSAutorun and then press the Jog
Dial navigator. Or, tap MSAutorun icon on the
Application Launcher screen.
MS Autorun application starts, and the list of applications in your
CLIÉ handheld appears.

4 Tap the application (PictureGear Pocket) for which you
want to set the auto-run function.

5 Tap Set.
The setting is stored in the Memory Stick media, and the
confirmation dialog box appears.

6 Tap OK.
The auto-run setting is completed.

7 Tap Home  to return to the Application Launcher
screen.

8 Remove the Memory Stick media.
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To use the auto-run function with this example
If the Application Launcher screen is displayed and you insert
Memory Stick media into your CLIÉ handheld, the PictureGear Pocket
application starts automatically. In this case, if you remove the
Memory Stick media, the PictureGear Pocket quits automatically and
the Application Launcher screen appears. For further information,
refer to the online manual for MS Autorun application.

Note

If “Internal” is displayed at the top center of the PictureGear Pocket screen
during operation described above, the image files stored in your CLIÉ handheld
are displayed.
To view image files stored in the Memory Stick media, tap the arrow V on the top
center of the screen to select “MS.”
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How to read the online manual

Detailed information on the MS Autorun application is provided in the
online manual on the supplied CD-ROM.
To view the online manual, the Adobe Acrobat Reader version 4.0 or
higher must be installed on your computer.

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Manuals.

4 Double-click MSAutorun Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed/updated

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Click Exit.

3 Double-click the My Computer icon on the Windows
desktop.

4 Right-click the CD-ROM drive icon, then click Open from
the shortcut menu.

5 Double-click the PC folder.

6 Double-click the Acrobat folder.

7 Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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MS Autorun menu items

The following items appear when you tap the MENU icon.
This section describes the menu commands specific to the MS Autorun
application.

Options menu

Display log
When Memory Stick media is inserted into or removed from your
CLIÉ handheld, a history log is created. From the Options menu, you
can view this information by tapping Display log.

Tools
The following buttons appear in the Tools dialog box:

• Recover:
This button is displayed if the auto-run function is performed and
the MS Autorun application is started without removing the
Memory Stick media. You can delete the application and database
files copied into your CLIÉ handheld.

• Delete autorun setting:
This button is displayed if the auto-run setting file is stored in the
inserted Memory Stick media. You can delete the auto-run setting in
the Memory Stick media.

Preferences
Displays the Preferences dialog box.
The following items appear on this dialog box:

•Autorun:s Disable:
You can temporarily cancel the auto-run function.

• MS List:
You can switch the format of the list of data in Memory Stick media.

About MS Autorun
The version information of the MS Autorun application is displayed.
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Copying the data to the Memory Stick media
on your CLIÉ handheld (MS Import/Export)

This chapter describes how to copy the data on your
computer to the Memory Stick media on your CLIÉ handheld
directly without performing HotSync operation.
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What you can do with MS Import/Export

Both Memory Stick (MS) Import and Memory Stick (MS) Export are
applications designed to help you copy the data on your computer to
the Memory Stick media on your CLIÉ handheld directly without
performing a HotSync operation.

When copying the data on your computer
You have to use both the MS Import application for your CLIÉ
handheld and the MS Export software for your computer at the same
time.

Before using the MS Import/Export applications
The MS Import application is already installed on your CLIÉ
handheld, but you have to install the MS Export software to your
computer (page 93).

Installing CLIÉ applications without performing a HotSync
operation
Using the MS Import/Export applications, you can install application
files (.prc or .pdb) for your CLIÉ handheld without performing a
HotSync operation.

Using your CLIÉ handheld as a removable disk
The MS Import/Export applications enable you to use the Memory
Stick media inserted in your CLIÉ handheld as another removable disk
drive on your computer. Like other removable drives, you can copy
and move files between your CLIÉ handheld and your computer using
the Windows® Explorer.
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Installing

You need to install the MS Export software on your computer. (The MS
Import application is already installed on your CLIÉ handheld).

1 Insert the installation CD-ROM into the CD-ROM drive of
your computer.
The setup program starts automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Install CLIÉ Utilities.

4 Click Install Memory Stick Export.
The installation starts.
Follow the instructions displayed on the screen.
After the installation is completed, the installation screen reappears.

5 Click Finish.
The installation of MS Export software ends.
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You can install applications for your CLIÉ handheld into the Memory
Stick media without performing HotSync operation, if you use MS
Import/Export applications.

1 Connect the cradle to a computer in which you have
installed the MS Export software.

2 Insert the Memory Stick media into your CLIÉ handheld.

3 Place your CLIÉ handheld on the cradle.

4 On the Application Launcher screen, rotate the Jog Dial
navigator to select MS Import and then press the Jog
Dial navigator.
The MS Import application starts.
Or, tap the MS Import icon on the Application Launcher screen.

5 Drag and drop add-on application files (.prc or .pdb) for
your CLIÉ handheld to the MS Export shortcut icon on
your Windows desktop.
These files are automatically copied to the appropriate folders.

If the application file type could not be recognized by the
MS Export

The Entry Form dialog box appears.
In this case, enter the application name and destination folder to
which the application will be copied.

6 When you finish, tap Disconnect or tap Home  .

Note

Do not remove the Memory Stick media while the cradle is connected to your
computer.

If your computer is Windows 2000/Windows Me
A warning message appears when you tap Disconnect on your CLIÉ
handheld.
Click OK, and then continue operations.

Installing CLIÉ applications using
MS Import/Export
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Confirming the contents of the Memory Stick media after
copying the application
Restart MS Export software, then click the Memory Stick Drive tab of
the MS Export software.

Note

You cannot copy applications by dragging them to the Memory Stick Drive
window of the MS Export software.
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Using your CLIÉ handheld as a removable
disk

1 Connect the cradle to a computer in which you have
installed the MS Export software.

2 Insert the Memory Stick media in your CLIÉ handheld.

3 Place your CLIÉ handheld on the cradle.

4 On the Application Launcher screen, rotate the Jog Dial
navigator to select MS Import and then press the Jog
Dial navigator.
MS Import application starts.
Or, tap the MS Import icon on the Application Launcher screen.

5 Operate the desired file or data using Windows Explorer,
etc.
Not only can you copy or delete data stored in the Memory Stick
media, you can also write data in your computer to the Memory
Stick media.

Note

When you copy the application to the PALM/Launcher folder of the
Memory Stick media, some applications on your CLIÉ handheld may not
display the file list of the Memory Stick media appropriately.

6 When you finish the operation, tap Disconnect or tap
Home  .

Note

Do not remove the Memory Stick media while the cradle is connected to your
computer.

If your computer is Windows 2000/Windows Me
A warning message appears when you tap Disconnect on your CLIÉ
handheld.
Click OK, and then continue with the operations.
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How to read the online manual

Detailed information on the MS Import/MS Export software is
provided in the online manual on the supplied CD-ROM.
To view the online manual, the Adobe Acrobat Reader version 4.0 or
higher must be installed on your computer.

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Select the model of your CLIÉ handheld (PEG-T615C or
PEG-T415).

3 Click Manuals.

4 Double-click MS Import Export Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed/updated

1 Insert the supplied CD-ROM in your computer’s CD-ROM
drive.
The install screen appears automatically.

2 Click Exit.

3 Double-click the My Computer icon on the Windows
desktop.

4 Right-click the CD-ROM drive icon, then click Open from
the shortcut menu.

5 Double-click the PC folder.

6 Double-click the Acrobat folder.

7 Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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MS Import menu items

The following item appears when you tap the MENU icon.
This section describes the menu command specific to the MS Import
application.

Options menu

About MS Import
Shows the version information of the MS Import application.
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Additional information

This chapter includes the index and appendix information.
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Appendix

Manufacturing companies supported by the CLIÉ
Remote Commander application

Note

Some devices cannot be remote-controlled depending on its model or the year of
its production.

TV
Sony, Akai, Emerson, General Electric, Hitachi, JVC, Magnavox,
Mitsubishi/MGA, NEC, Panasonic, Philips, Pioneer, RCA/PROSCAN,
Samsung, Sanyo, Sharp, Symphonic, Toshiba

VCR
Sony, Aiwa, Akai, Emerson, Funai, General Electric, Hitachi, JVC,
Magnavox, Mitsubishi/MGA, NEC, Orion, Panasonic, Philips, Pioneer,
RCA/PROSCAN, Samsung, Sanyo, Sharp, Symphonic, Toshiba

DVD
Sony, Aiwa, Denon, Harman/Kardon, Hitachi, JVC, KLH, Onkyo,
Panasonic, Philips, Pioneer, RCA, Samsung, Sharp, Shinco, Sylvania,
Thomson, Toshiba, Yamaha, Zenith

AV-AMP (amplifier)
Sony, Kenwood, Onkyo, Pioneer, Technics, Yamaha



103

A
dditional inform

ation
Chapter 9



For the latest support information,
check our official Sony CLIÉ Web site

http://www.sony.com/clie/
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